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1. UVOD 

 

EPLAN pruža programska rješenja i usluge na području elektrotehnike, automatizacije i 

mehatronike. Razvio se u jedan od vodećih svjetskih programskih rješenja za projektiranje 

strojeva, postrojenja i elektro ormara. Digitalizacija predstavlja brojne izazove za tvrtke iz svih 

industrija. Na cijelom području inženjeringa upravljačkih ormara i sustava sklopne opreme 

vremenski pritisci određuju svakodnevno poslovanje. Uz to, postoje ogromni pritisci troškova, 

primjerice zbog visokog udjela fiksnih troškova ormara, elektrotehničke opreme, ambalaže i 

plaća. Kupci također imaju visoke zahtjeve: od individualiziranog koncepta rješenja 

do masovnog prilagođavanja, kratke rokove isporuke te visokokvalitetne sklopne sustave i 

dokumentaciju  po najnižoj mogućoj cijeni. Brzo postaje jasno da su potrebna integrirana 

poboljšanja kvalitete procesa. [1]   
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1.1  Zadatak diplomskog rada 

 

Zadatak rada je napraviti da se korištenjem programa ˝EPLAN˝ naprave predlošci za interaktivne 

vježbe kroz koje bi studenti mogli izučavati korištenje suvremenih programskih alata. Prikazat će 

se izrada tehničke dokumentacije električne i komunikacijske instalacije automatiziranog 

industrijskog postrojenja od instalacija napajanja i zaštite, pa do instalacije nadzora i 

komunikacije. Priručnik će sadržavati uvod u korištenje EPLAN programa te razvodni ormar 

strojarnice „RO-STROJ“ predstavlja ormar automatike koji upravlja HVAC (eng. Heating, 

ventilation, and air conditioning) sa sustavom stambenog prostora.
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2. EPLAN 

 

EPLAN Electric kao vodeći svjetski programski paket za inženjiring nudi neograničene 

mogućnosti prilikom projektiranja elektrosustava u fazi izrade električnih shema i prateće 

projektne dokumentacije. Dio opsežnog sustava dokumentacije je automatsko generiranje 

detaljnih izvještaja baziranih na strujnim shemama, koje omogućava sljedeće faze projekta poput 

prozvodnje, sastavljanja i puštanja u pogon. [2] 

U programu EPLAN na alatnoj traci odabiremo ikonu za otvaranje novog projekta (slika 2.1.).  

 

Slika 2.1 Ikona za otvaranje novog projekta 

 

2.1. Definiranje direktorija 

 

Za definiranje direktorija potrebno je kliknuti na traci sa izbornicima ˝OPTIONS˝ (slika 2.2). 

 

Slika 2.2 Traka s izbornikom 

Nakon izvršenog prethodnog koraka otvara se padajući izbornik (slika 2.3). U padajućem 

izborniku odabrati ˝Settings ˝. 

 

Slika 2.3 Izbornik 
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Nakon izvršenja prethodnog koraka otvara se prozor za podešenja. Potrebno je izvršiti sljedeće 

naredbe klikom na mape i registar da bi se došlo do definiranja direktorija. ˝User → Managment 

→ Directories˝. Nakon izvršenja prethodnih koraka dolazi se do postavki direktorija (slika 2.4.). 

 

Slika 2.3 Postavke direktorija 

 

2.2. Radno okružje 

 

Radno okruženje sadrži kombinacije i izbor koji ubrzava proces izrade shema ili uređivanja 

podataka. Radno okruženje odabire se pomoću opcije u izborniku View → Workspace. 

Workspace je jednostavno prenositi s jednog sučelja na drugo zbog mogućnosti exportiranja i 

importiranja. 

Izabiranje radnog okruženja se izvodi na sljedeći način. Na traci sa izbornicima kliknuti ˝View˝ 

(slika 2.4). 

 

Slika 2.4 Traka sa izbornikom  
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Slika 2.5 Radno okružje (eng. Workspace) 

2.3. Alatna traka  

 

Prema svojim potrebama svaki korisnik može kreirati svoju alatnu traku. Desnim klikom na 

alatnu traku dobije se popis opcija koje se mogu isključiti i uključiti po potrebi. 

 

 

Slika 2.6 Alatna traka (eng. Toolbar) 
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Ukoliko se odabere opcija „Customize“ gdje se može kreirati vlastita alatna traka sa svojim 

komandama. Nakon izrade prazne alatne trake potrebno je dodati zadane funkcije. Dodavanje 

funkcija se izvršava da u prozoru ˝Customize˝ klikne na ˝Commands˝ gdje će se dobiti popis 

naredbi koji je moguće postaviti u alatnu traku (slika 2.7.). 

 

Slika 2.7 Prozor ˝Customize˝ 

 

2.3. Kratice 

 

Kratice za komande u programu koje značajno ubrzavaju rad prilikom izrade shema mogu se 

kreirati na Options → Settings → Shortcut keys.Također na jednostavan način se prenose s 

računala na računalo pomoću opcije Export/Import.  
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Slika 2.5. Kratice (eng. Shortcut keys) 

 

Tablica 2.1 Često korištene funkcije 

Crtl + F pritiskom na element odlazimo gdje je dalje 

spojen (follow) 

 

Ctrl + enter novi red, što je bitno prilikom npr. upisa u 

labele  

D duplicate, radi kopiju elementa iz sheme 

 

 

V 

pomicanje elementa  

M pozivanje baze podataka  
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CTRL+SHIFT+U točka za prekidanje neželjene linije između 

komponenti  

 

 

2.4 Rad s projektom   

 

Projekt je vremenski određena aktivnost s ciljem proizvodnje rezultata, usluga i jedistvenog 

proizvoda. Proces upravljanja projektom su: 

 iniciranje → planiranje → izvršenje → nadzor nad projektom → završni procesi 

2.5. Novi projekt 

 

Otvara se na osnovu predloška (eng. Template) koji se može kreirati ili se koristi već postojeći. 

Predlošci se kreiraju: Project → Organize → Create Basic Project / Create project template. 

Opcijom „New Project“ otvara se direktorij kojemu je potrebno dodijeliti ime projekta te je 

potrebno odrediti direktorij gdje će se projekt spremiti (Slika 2.6.). [2] 
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Slika 2.6 Otvaranje novog projekta  

U polja se upisuju podaci o projektu koji se vide na naslovnici (Cover page), slika 2.7. Izmjene 

se rade desnim klikom na naslov projekta → Properties. Na naslovnici nalaze se: logo od 

klijenta, tvrtkin logo, opis projekta, ime ormara, broj dokumenta, broj posla, broj revizije, opis 

revizije, napon, pomoćni napon, istosmjerni napon, tip uzemljenja, itd. 
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Slika 2.7 Naziv projekta 

 

Na alatnoj traci odabiremo „ Project data“ (Slika 2.8.) te potom „Structure identifier managment“ 

pomoću kojeg će se definirati struktura projekta (Slika 2.9.). Prilikom ulaska u prozor potrebno 

je izvršiti funkciju „Clean up all“ kako ne bi došlo do preklapanja strukture iz nekog drugog 

projekta.  

 

Slika 2.8 Alatna traka 
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Slika 2.9 Prozor strukture projekta 



12 
 

Kreiranje predloška radi se na način da se odabire „Project“ → „Organise“ → „Create Basic 

Project“ (Slika 2.10.) te je potrebno odabrati slijedeći predložak i spremiti (Slika 2.11). 

 

Slika 2.10 Izbornik za kreiranje predloška 
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Slika 2.11 Create basic project 

Ulaskom u „Settings“ na način kako je gore prikazano U prozoru postavki otvoriti mape 

˝Project˝ i i sada se mogu podesiti željene postavke projekta (slika 2.12.). 

 

Slika 2.17 Postavke projekta 
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2.6. Stranice 

 

Za izradu nove stranice potrebno je imati prethodno izrađen projekt. Otvaranje nove stranice 

izvodi se na sljedeći način. Na traci sa izbornicima odabrat ˝Page˝ Nakon izvršenog prethodnog 

koraka otvara se padajući izbornik gdje je potrebno odabrarti „New“ (slika 2.18.). [3] 

 

Slika 2.18 Nova stranica 

 

Slika 2.19 Stranica projekta 
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Nakon odabira nove stranice, imamo mogućnost kreiranje strukture gdje nam „=“ označava 

funkcije veće važnosti te „+“ što označava da se plan razvodnog ormara strojarnice (RO-S) 

prikazuje pod funkcijom „=PLAN“ (Slika 2.19). 

Kada se odabere naziv stranice i „Type page“ s obzirom na to što nam treba, a u ovom slučaju su 

to tropolne sheme, odabiremo „OK“ te dobijemo slijedeći prikaz (Slika 2.20). 

 

 

Slika 2.20 Struktura projekta 

 

Desnim klikom na prvu stranicu odabire se „Properties“ te se unose željeni podaci poput opisa 

stranice, revizije, projektanta i datuma izrade (Slika 2.21.). Prilikom izrade strujnih shema 

potrebno je podesiti nekoliko stvari koje olakšavaju proces crtanja. Standardni GRID za 

električne sheme bude 2mm ili 4mm što možemo podesiti na alatnoj traci

 ili se još može vidjeti u donjem desnom kutu stranice 

. . 
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Slika 2.21 Svojstva stranice 

U prozoru postavki otvoriti ˝User → Graphical editing → 2D˝. Nakon izvršenja prethodnih 

koraka u odabranim postavka može se izvršiti podešenje vrijednosti levela mreže (slika 2.22.). 

 

Slika 2.22 Svojstva stranice 
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2.7. Simboli 

 

Prije početka izrade shema potrebno je podesiti ili provjeriti dostupne baze simbola koje će se 

koristiti u projektu. EPLAN podržava različite varijante simbola prema različitim normama . 

Podešenje baze simbola izvodi se na sljedeći način. Na traci sa izbornicima odabrati ˝Options˝ → 

„Project“ → „Managment“ → „Symbol libraries“ (2.23.). 

 

 

Slika 2.23 Baza simbola 

 

Za ubacivanje simbola u shemu koristimo ikonu na alatnoj traci te možemo vidjeti prikaz svih 

simbola koji su u bazi podataka (2.24). 
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Slika 2.24 Baza simbola 
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3. IZRADA ELEKTRIČNIH SHEMA 

3.1. Tehnički zadatak  

 

Zadatak ovog ormara je bio riješiti problematiku automatizacije grijanja i hlađenja stambenog 

prostora koji je grijan i hlađen pomoću dizalice topline i kondenzatorskog bojlera. Za protok 

vode sustav koristi cirko pumpe, a temperaturni signal u sustavu dobivamo pomoću PT sondi.  

Treba odabrati sve potrebne komponente koje su nam potrebne kako bi mogli isprojektirati 

sustav koji može riješiti gore navedeni problem grijanja i hlađenja stambenog prostora. Za 

ovakav sustav potrebni su nam:  

-osigurači, releji, ispravljač, PLC, ekstenzije te druga servisna oprema.  
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3.2. Izgled ormara 

 

Vanjski izgled ormara radi se na način da iz baze podataka odabire vanjski izgled ormara prema 

zadanim specifikacijama (Slika 3.1).  

 

Slika 3.2 Vanjski izgled razvodnog ormara 
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Unutarnji izgled ormara izrađuje  se prilikom završetka projekta kada su sva polja ubačena i 

spojena. Slaganjem se nastoji maksimalno iskoristiti prostor ormara, uz zadovoljene sve 

funkcionalnosti, a uz to da ostane logičan slijed električnih komponenti koje se mogu pratiti 

prema shemi (Slika 3.2.). 

 

Slika 3.2 Unutranji izgled razvodnog ormara 

Oznake elemenata moraju biti jednake veličine, a tekst ne smije biti jedan preko drugog te mora 

biti jednake veličine. Razmak između kanalica mora biti minimalno 150mm. Stezaljke trebaju 

biti označene istim imenom kao što su označene u shemama. Pri slaganju elemenata treba 

obratiti pažnju na naponske razine.  
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3.3. Rješavanje problema 

 

3.3.1. Dolazne linije napajanja  

 

Na slici je prikazana dolazna linija napajanja cijelo razvodnog ormara strojarnice sa prikazanim 

glavnim elementima (Slika 3.3.). 

Osigurač -  svrha osigurača je štićenje opreme iza osigurača, prekida napajanje u slučaju 

preopterećenja (Slika 3.4.). [4] 

Ispravljač - električni uređaj za napajanje trošila pretvaranjem izmjenične električne struje u 

istosmjernu što ovdje znači da imamo pretvaranje s 230 VAC na 24 VDC (Slika 3.5.). 

Servisne priključnice (Slika 3.6.). 

 

Slika 3.3 Dolazno napajanje 

 

https://enciklopedija.hr/natuknica.aspx?ID=69610
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Slika 3.4 Automatski osigurač – stvaran prikaz [5] 
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Slika 3.5 Ispravljač – stvaran prikaz [5] 

 

 

Slika 3.6 Servisna priključnica – stvaran prikaz [5] 
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3.3.2. PLC 

 

Pomoću programibilnog logičkog kontrolera “PLC” i njegovih ekstenzija za analogne inpute koji 

upravljaju ventilokonvektorima, pumpama, dizalicom topline i kondenzacijskim bojlerom (Slika 

3.7.). 

 

 

 

 

 

Slika 3.7 Upravljanjem PLC-om 
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3.3.3. Osigurači i releji 

 

Koristili smo 8 osigurača od kojih je na -1F1 dolazno napajanje, -1F2 spojen je istosmjerni 

ispravljač, na osiguračima 1F3 i 1F4 spojene su servisne priključnice. Osigurači oznaka od -1F6 

do -1F9 spojene su cirko pumpe koje služe za brže protjecanje vode (Slika 3.8.).  

 

Slika 3.8 Osigurač 

Stakleni osigurači - svrha osigurača je štićenje opreme iza osigurača (Slika 4.9). 

  

Slika 3.9 Stakleni osigurač [5] 

 

Za okidanje pumpi, bojlera i dizalice topline korišteni su releji oznaka D1-D7. Sklopni aparat 

koji mjeri neku pogonsku veličinu (struju, napon, tlak, brzinu vrtnje, temperaturu, snagu) te pri 

određenoj vrijednosti te veličine automatski zatvara ili otvara svoje kontakte. (Slika 4.10.) 
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Slika 3.10 Relej 
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4. IZVJEŠTAJ  

 

Da bismo generirali izvještaj potrebno je otići na Utilities → Reports → Generate (Slika 4.1.). 

Gdje nam se otvori prozor s predloškom izvještaja. (Slika 4.2.). 

 

Slika 4.1 Generiranje izvještaja 

 

Slika 4.2 Generiranje izvještaja 

Nakon „OK“ otvara se prozor u kojem se nalazi predložak za identifikaciju strukture izvještaja. 

(Slika 4.3.). 
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Slika 4.3 Izvještaj 

 

„+STEZALJKE“ sadrži sve stezaljke koje smo naveli u projektu, spojno mjesto, vrstu stezaljke 

te referencu stranice na kojoj jesu. „+LISTA DIJELOVA“ sadrži listu svih elemenata sa svojim 

partovima te opisom značenja, također ima referencu za stranicu na kojoj taj element je. (Slika 

5.4.). 
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Slika 4.4 Lista dijelova 
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4.2. Spremanje projekta 

 

Pri završetku projekt je potrebno  spremiti, a to se radi na način da odemo na alatnu traku i 

klinemo ikonu   koja služi za “back-up projekta” (zw.file) ili na način da u alatnoj traci 

odaberemo “Project” → “Back up” → “Project” (Slika 4.5.). 

 

Slika 4.5 Spremanje projekta 
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Slika 4.6 Otvaranje direktorija za spremanje projekta 

Nakon toga se otvori prozor u kojem je potrebno odabrati direktorij u koji spremamo sami 

projekt (Slika 4.6.) 

 

Ukoliko želimo izvući PDF document, projekt možemo ponovno s alatne trake kliknuti ikonu  

 ili ili na način da u alatnoj traci odaberemo “Page” → “Export” → “PDF” (Slika 4.7.). 
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Slika 4.7 Spremanje projekta u obliku PDF dokumenta 
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4.3. Tehnička dokumentacija razvodnog ormara strojarnice 600x600 

 

RO-STROJ predstavlja ormar automatike koji upravlja HVAC (eng. Heating, ventilation, and 

air conditioning) sa sustavom stambenog prostora. Ormarić je dimenzija 600x600. 

 

 

Slika 4.8 Stvarni prikaz ormarića [6] 
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Slika 4.9 Glavno napajanje (eng. Main line) [6]

 

Slika 4.10 Cirko pumpa za radijatorsko grijanje  [6] 
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Slika 4.11 Cirko pumpa - ventilokonvektori 1.kat uredski dio - grijanje/hlađenje [6] 

 

 

Slika 4.12 Cirko pumpa ventilokonvektori 1.kat u pogonu - grijanje/hlađenje [6] 
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Slika 4.13 Cirko pumpa ventilokonvektori prizemlje grijanje/hlađenje [6] 

 

 

Slika 4.14 Plinski kondenzacijski bojler [6] 
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Slika 4.15 Dizalica topline [6] 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.16 CYBRO-3, napajanje i vrsta komunikacije [6] 
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Slika 4.17 Digitalni output - 10 DO [6] 

 

 

Slika 4.18 Analogni output/input – 4 AI/AO [6] 
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Slika 4.19 Digitalni input – 12 DI [6] 

 

 

 

Senzor PT1000 je senzor tipa RTD (eng. Platinum Resistance Temperature Detectors) i njihov 

otpor gotovo linearno varira s promjenom temperature. Uz funkciju termometara, oni imaju i 

funkciju rješavanja temperaturnih anomalija. Prisustvo digitalnog regulatora ove senzore čini 

idealnim ne samo zbog mogućnosti kontroliranja temperature, već i zbog programiranja 

rezolutivnih intervencija u trenutku kada se dostigne kritična vrijednost. Dostupni su različiti 

standardni i personalizirani modeli, kako bi na najbolji način bile zadovoljene sve potrebe 

klijenta. Na slici 4.20 je prikaz sheme spajanja PT1000 sonde.[7] 
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Slika 4.20 Shema spajanja PT1000 sondi - 12 analogni RTD inputi [6] 
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Slika 4.21 Cybrotech CYBRO 3-24 [6] 

 

 

Slika 4.22 Cybrotech CYBRO 3-24 [6] 
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Slika 4.23 Cybrotech AIR-12 [6] 
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Slika 4.24 Cybrotech AIR-12 [6] 
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Slika 4.25 Lista dijelova (eng. Parts list) [6] 

 

Slika 4.26 Pregled rednih stezaljki (eng. Terminal diagram) [6] 

 

Slika 4.27 Pregled kabela [6] 
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5. ZAKLJUČAK 

 

Pri izradi diplomskog rada prikazani su primjeri ormarića gdje je zadatak bio prikazati 

komponente, layout te način rada u program EPLAN. Kroz poglavlja su redom opisani postupci 

izrade jednog projekta. CIlj je da se studenti upoznaju s praktičnim dijelom izrade projekata i 

projektne dokumentacije. Ovakav način rada ima veliki značaj za studente koji izlaze s fakulteta 

kako bi se lakše prilagodili i već bili upoznati s radom na projektu i izrade istog.  
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